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Fargeinnstillinger

Farge er et avansert tema som er et kurs i seg selv. Adobe Photoshop Elements 5.0 lar deg
sette opp en fargeprofil. En litt overforenklet forklaring er at fargeprofiler brukes som et
medium til & kunne formidle presis fargeinformasjon til en rekke enheter som for eksempel
skrivere, skjermer, trykkemaskiner osv. Alle bgr kalibrere skjermene sine enten du er
hobbyfotograf eller profesjonell fotograf. Serigse skjermfabrikanter leverer ogsa icc-profiler
med skjermen du kjaper. Dette er fabrikklagde fargeprofiler for din skjermtype og modell. A
bruke fargeprofiler er selvsagt valgfritt, selv om jeg har lyst til & si at det ikke er det, men det
anbefales at du bruker en fargeprofil for din monitor. Dersom det er avvik fra fargene i bilde-
eksemplene i heftet som du har lastet ned fra Internett og de som du lager etter heftets
beskrivelser er arsaken sannsynligvis at du og jeg bruker forskjellige fargeinnstillinger.

Et vanlig problem som du vil state pa er at fargen pa en utskrift ikke stemmer med den du ser
pa skjermen. | prosessen hvor bildet ditt flyttes fra et digitalt kamera eller skanner til skjermen
for sa & bli skrevet ut vil fargene endres. Dette fordi de ulike enhetene behandler farger
forskjellig. Vil du forsikre deg at om at alle andre ser et bilde slik du ser det, inkluder en
fargeprofil for alle dine bilder. Photoshop Elements har et fargestyringsverktay du ma bruke
for & skjermfargene til a bli mest mulig like utskriftene dine.
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Mine innstillinger

@nsker du a endre dine innstillinger slik at vi far et mest mulig likt utgangspunkt, velg Edit >
Color Settings i Adobe Photoshop Elements 5.0. Bildene som det er henvist til i dette heftet
ble laget med fglgende fargeinnstillinger:

Color Settings il
l:? Learn more about: Color Settings
Cancel I

— Choose how to manage color in your images:
" No Color Management
(" Limited Color Management

Limited Color Management is optimized for the Web, It uses sRGE for the
wiorking space.

% Full Color Management
Full Color Management is optimized for printing. It uses Adcbe RGE as the

working space, preserves existing profiles, and allows you to chooss sRGE or
Adobe RGB when opening images without profiles,

Du kan gjere endringer i dialogboksen for Color Settings ved & ga til Edit > Color Settings for
a fa frem dialogboksen og gjere ovenfornevnte endringer.

Macintosh-brukere kan bruke Apple-kalibreringsverktayet for sine skjermer. Windows-
brukere kan bruke Adobe Gamma Utility. Du finner det i kontrollpanelet.

Kalibrere skjermen med Adobe Gamma

Dersom du ikke allerede har kalibrert skjermen din, bgr du absolutt gjere det. Denne
gjennomgangen av fargekalibrering av skjerm er bare farste steget av mange som du kan
gjare for & fa kontroll pa fargene i din arbeidsflyt. Minstekravet er du i hvert fall kalibrerer
skjermen om ikke annet kan du avslutte med det.

Det a kalibrere skjermen er noe du simpelt hen bare ma gjere for a sikre deg at du far valuta
for din investering i utstyr, tid og anstrengelser i arbeidet med digitale bilder. Det a kalibrere
skjermen din er en grei prosess og tar maksimalt ti minutter av din tid.

Bruk Adobe Gamma for & kalibrere skjermen din. Dette er et hjelperedskap som har to viktige
funksjoner. For det farste hjelper Adobe Gamma deg a kalibrere eller tilpasse din monitor slik
at du kan se fargene pa skjermen din optimalisert ut fra det skjermen kan levere.

For det andre lager Adobe Gamma en profil som brukes av Adobe Photoshop Elements 5.0 og
operativsystemet ditt for a hjelpe til & vise farger mest muslig korrekt.

Begge disse funksjonene er verdt bryet dersom du tar deg tiden til & gjennomfgre dem sa godt
som mulig.

@nsker du ytterligere presisjon ma du vurdere a kjgpe et tilleggsprodukt som er adskillig mer
ngyaktig. Det finnes bade programvare-verktgy og program-/maskinvare kombinasjoner som
ColorVision eller OptiCal LCD/CRT Spyder med enten ColorVision eller OptiCal
programvare.

Avhengig av din behov og din maskinvare, og kanskje ogsa litt hell, kan du gjere en ganske
bra jobb med & kalibrere skjermen din ved hjelp av Adobe Gamma. Adobe Gamma-verktgyet
kan vare nyttig verktgy for de som har en egen evne til a kunne lgse ting pa en god mate hver



gang. Slutningen blir at det kan vare en ide & bruke Adobe Gamma-verktgyet farst — er du
ikke ferngyd med resultatet kan du ta en titt pa hva som finnes av program- og maskinvare for
a kalibrere din skjerm og forsgke en av disse.

Kalibrering trinn for trinn

Her far du en trinnvis gjennomgang av hvordan du kalibrerer skjermen din ved hjelp av
Adobe Gamma.

Trinn 1: Gjer deg Klar til & kalibrere monitoren din

Hvorvidt du far suksess ved hjelp av Adobe Gamma er avhengig av lysforholdene. Har du
direkte sollys fra et naerliggende vindu eller at du har pa deg en hvit eller farget t-skjorte som
reflekterer farge eller hvitt lys pa skjermen din, kan du like gjerne hoppe over hele prosessen
med Adobe Gamma. Det beste miljget for a kalibrere din skjerm og gjere kritiske
fargeinnstillinger i er i et miljg med dempet eller dust lys. Jeg arbeider selv i et glasshus hvor
store deler av kontoret mitt er omgitt av vinduer. Selv om vinduene har tonet glass blir det
likevel mye stralys som slipper inn derfor bruker jeg en skjerm med hood (en skjerm rundt
monitoren)

for & skjerme for stralys, og bruker en mgrk genser nar det er snakk
om serigse prosjekter. For & trekke dette enda lengre kan er f.eks. den
beste tiden a arbeide pa i lyse kontorlandskaper enten tidlig om
morgenen eller sent pa ettermiddagen, eventuelt pa natten. A se
Adobe Gamma-verktayet mot gra desktop hjelper ogsa.
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Bruker du Widows, hgyreklikk pa Skrivebordet og velg Egenskaper for a apne dialogboksen
Egenskaper for Skjerm. Klikk fanen for Utseende og velg Skrivebord fra rullegardinmenyen
under Element. Klikk deretter pa en medium gra farge i fargevelgeren i nedre hgyre hjgrne av
dialogboksen. Klikk OK for & godta innstillingen.

Far du setter i gang bar monitoren din ha veert pa minst en time far du bruker Adobe Gamma.
Det tar en viss tid for fargene i en monitor stabiliseres etter at skjermen er blitt slatt pa.
Fargene i en skjerm avviker ogsa over tid. Avhengig av hvor ofte monitoren brukes bar du i
hvert fall en gang i kvartalet sgrge for at fargeprofilen svarer til skjermens karakteristika.

Trinn 2: Apne en fil

For du dpner Adobe Gamma foreslar jeg at du apner et digitalt fotografi i Adobe Photoshop
Elements 5.0 for & bruke dette som en realitetssjekk eller referanseramme om du vil. Nar du
kommer til trinn 10 far du muligheten til & bytte frem og tilbake mellom "fgr” og “etter”
innstillingene. Dersom du allerede har dpnet et digital fotografi i programmet vil det vere
mulig for deg a se klarere om du har forbedret innstillingene for monitoren.

Velg File > Open (Ctrl + O) for a fa frem dialoghoksen Open. Dobbeltklikk mappen Kap_002
for & apne den, og klikk deretter pa filen lotus.tif for a velge den. Klikk deretter Open-
knappen for a apne filen. Dobbeltklikk pa bildevinduet for @ maksimere dokumentvinduet.
Klikk deretter pa bildevinduet og plasser det slik at det dekker det meste av arbeidsomradet i
Photoshop. Flytt deretter programvinduet for Photoshop slik at det dekker omtrent en
fjerdedel av skrivebordet ditt, og flytt det opp til venstre slik at det er ute av veien for
dialogboksen til Adobe Gamma-verktgyet i trinn 3.

Trinn 3: Start Adobe Gamma

Adobe Gamma er et hjelpeverktay som enten kan kjares ved hjelp av en enkelt dialogboks
eller ved hjelp av en veiviser (Wizzard) som viser hver gjennom de ni trinnene i ni separate
dialogbokser. Uansett hvilken metode du matte bestemme deg for kan hele prosessen a
tilpasse og justere skjermen ta mindre enn fem minutter etter at du har gjort det et par ganger.

Nar Adobe Gamma installers i kontrollpanelet under installasjonsprosessen av Adobe
Photshop Elements 5.0 kan du starte det ved a dobbeltklikke pa Adobe Gamma-ikonet etter at
du har apnet Kontrollpanelet.
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Etter at Adobe Gamma er startet far du frem en dialogboks vist under. Jeg foreslar at du i
farste omgang bruker veiviseren som fglger deg igjenom prosessen trinn for trinn. Det er ogsa
standardvalget. Klikk Next for & bekrefte at du velger step-by-step Wizzard eller veiviseren
om du vil.
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Thiz contral panel will allow you to calibrate
your monitar and create an ICC profile for it

Which version would vou like o use?

% Step By Step [Wizad)
" Control Panel

__‘
“ ¥
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= MY ColarSync® on Macintosh® and 1CH
— 2.0 on Windows.

Fozition thiz dialog on the maonitar that
you wizh to calibrate,
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Trinn 4: Navngi profilen

Selv om det ser ut til at du bare navngir den nye profilen i dette trinnet, velger du faktisk
profilen som du brukte som startpunkt for din kalibrering ogsa. Derfor er det viktig at du
velger den beste profilen for din monitor sa langt det lar seg gjare. Teoretisk er det mulig a
velge en feil profil som ikke lar deg kalibrere skjermen ordentlig. Denne initiale eller farste
profilen velges basert pa hvilket operativsystem du bruker og om du bruker Macintosh eller
Pc. I mange tilfeller er den initiale fargeprofilen ikke den optimale. Det beste er om du selv
velger en profil. | dialogboksen under ser du at det finnes en Load-knapp. Bruk denne for &
hente frem den beste fargeprofilen tilgjengelig for din skjerm. Jeg har valgt Adobe RGB
(1998), men det kan hende at det fglger med en bedre profil til skjermen din.
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that will appear in application pop-up menus.
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Thiz profile will zerve az a starting point far the
calibration of your manitor. [F you wish to start
with a ditferent profile, click on Load.
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Trinn 5: Justere kontrast og lyshet

Klikk Next for & vise den neste dialogboksen. Sett deretter kontrasten (Contrast) til den
hayeste innstillingen for skjermen, vanligvis er det 100%. Bruk deretter kontrollen for lyshet
(Brightness) og juster skjermen inntil senterboksen er sa mgrk som mulig, men ikke helt sort,
slik at rammen rundt forblir hvit.

Adobe Gamma Wizard x|

The first step in calibrating your monitor is to
adjust the brightness and contrast contrals to
their optimal settings.

e ¢p First, set the contrast control b its highest
' setting.

.. Then, adjust the brightness

D control to make the center
box as dark az possible [but
not black] while keeping the
frame a bright white.
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Trinn 6: Velg fosfortype

Klikk Next for komme til den neste dialogboksen hvor du kan velge forsfortype (Phosphor).
Les dokumentasjonen som fulgte med skjermen din for a angi de korrekte innstillingene for a
avgjere hvilken phosfor type som er best for din monitor. Dersom det ikke star noe om dette i
dokumentasjonen som fulgte med monitoren din, se om du kan legge merke til to lysegra
linjer som gar horisontalt over skjermen. En linje omtrent ¥ ned fra toppen og en linje ¥ fra
bunnen. Dersom du har disse linjene bruk Trinitron-innstillingene. Har du ikke en Trinitron-
skjerm er sjansene gode for at du kan oppna gode resultater ved a velge P22-EBU-
innstillingene, da disse to leverandgrene produserer majoriteten av monitorer, og dette er
innstillingene fra disse leverandgrene.
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Trinn 7; Juster RGB Gamma

Klikk Next og fjern avmerkingen i boksen ved siden av View Single Gamma Only.
Dialogboksen viser na red, green og blue-bokser som vist i bildet under. Du kan na gjare
individuelle justeringer for hver farge uavhengig av hverandre. Malet er & justere hver av de
tre handtakene, slik at senterboksene fader inn i den mgnstrede rammen og saledes fjerner
ubalanse i skjermfargene. Selv om dette ser enkelt ut tar det litt tid og gvelse, spesielt med
green som synes a vere litt vanskeligere enn de to andre.

Adobe Gamma Wizard x|

The gamma setting of yaur manitar defines haw
bright your midtones are. Establizh the curent
gamma by adjusting the slider until the center

box fades into the pattemed frame.
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Dersom du kaster et blikk pa skjermen og vender hodet ditt litt vil du etter hvert kunne klare a
plassere de tre handtakene i samme posisjon hver gang. Justering krever gvelse, prev derfor et
par ganger for hver farge inntil du er blitt fortrolig med at du stiller dem inn korrekt. Dersom
du er helt pa jordet, vet du det, og kan preve igjen. Noen ganger kan det & se bort fra skjermen
et gyeblikk og flytte blikket tilbake ogsa hjelpe.



Bruker du Windows operativsystem, sett Gamma til Windows Default og verdien 2.20 vil bli
vist. Macintosh-brukere bar velge Macintosh Default og bruke en verdi pa 1.80.

Trinn 8: Velg hvitpunkt for maskinvaren

Klikk Next for & ga til den neste dialogboksen. Adobe Gamma gjgr vanligvis selv denne
innstillingen korrekt. Dersom monitoren har muligheten til & angi hvitpunkt (white point) for
maskinvaren, sjekk om denne innstillingen matcher innstillingene for monitoren. (Vanligvis
har monitoren en skjerm-meny og knapper i bunnen av skjermen som du kan justere).

Adobe Gamma Wizard |

The white point of your monitar determines whether
ypou are uzing a warm or cool white.

The hardware white point of your manitar iz zhown
below, [F pow know thiz to be incorect, chooze a

different setting. Or click on Measure to vizually
estimate it.
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Trinn 9: Velg hvitpunkt

Klikk Next for & ga til den neste dialogboksen som tar for seg White Point-innstillinger (angi
hvitpunktet). | de fleste tilfeller gnsker du at White Point-innstillingene er de sammen som for
maskinvaren.

Adobe Gamma Wizard x|

Y'ou can chooze to work, at a different white point
thian your monitor's hardware zetting. The current
adjuzted white point iz ghown below, IF desired,
chooge a new value.,

Adjusted *white Point;
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Trinn 10: Sammenlikn resultatene “fgr” og “etter”

Klikk Next for & ga til den neste og siste dialogboksen i denne prosessen. Nar du klikker
Before og After vil du se forskjellen mellom innstillingene du hadde far du begynte a bruke
Adobe Gamma og innstillingene som du nettopp har valgt. Skulle disse "far” og "etter”
innstillingene vise seg a veere verre enn de du hadde fer du begynte, klikk Back-knappen
inntil du far tilgang til innstillingene du trenger. Fortsett & prgve inntil du finner de optimale
innstillingene for din monitor. Bildet du dpnet i Photoshop i trinn 2 kan hjelpe deg til & se
forskjellene i "far” og “etter” innstillingene.

Trinn 11: Lagre profilen

Etter at du er forngyd med resultatet, klikk Finish-knappen for & fa frem Save As-
dialogboksen. Du blir na bedt om a skrive inn et navn pa profilen som du akkurat har laget.
Jeg foreslar at du bruker et nvn som likner pa det originale filnavnet som du begynte med,
men legg til dine initialer og datoen for nar profilen ble laget. Pa denne maten kan du lett
huske at det er du som har laget denne profilen og datoen for néar den ble lagd. Klikk deretter
Save og lukk Adobe Gamma. Din monitor er na kalibrert og du har laget en skjermprofil. Du
er na klar for a komme i gang med serigs digital bildebehandling i Adobe Photoshop Elements
5.0 i neste kapittel, og har i stgrre grad sikret deg at det bildet du ser pa skjermen ser likt ut
ogsa for andre nar de ser det pa en annen datamaskin. Husk a be dine venner om a kalibrere
sine skjermer ogsa, eller du kan gjare jobben for dem.
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